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chapter 1

Using This Guide
The DigiDrive™ uses an innovative new Quiet-
Drive™ technology. This technology allows the 
DigiDrive to perform as one of the fastest 
(10,000 rpm) and quietest drives on the market 
today. In addition, the DigiDrive is designed for 
rack-mounting in industry-standard racks (with 
the optional Avid/Digidesign Rack Mount Kit), 
or multiple drives can be stacked on top of one 
another to minimize desk-space requirements. 

About This Guide

The information in this guide is a supplement to 
the hard drive installation instructions found in 
the setup guide that came with your Digidesign 
system. This guide contains alternative DigiD-
rive installation and configuration instructions. 

This guide contains the following information:

◆ Chapter 2, “Overview”, describes the front 
and rear panels of the DigiDrive. It also includes 
information on SCSI bus configuration, LVD 
and single-ended SCSI standards, available SCSI 
cables, considerations for mixing wide drives (rS 
and iS) and narrow DigiDrives on the same SCSI 
bus, and SCSI bus termination requirements.

◆ Chapter 3, “Installation”, provides step-by-
step instructions for connecting a DigiDrive to 
your Digdesign system. 

◆ Chapter 4, “SCSI Performance Guidelines”, 
documents performance guidelines for SCSI 
hard drives.
◆ Chapter 5, “DigiDrive Management for 
Mac OS”, covers management and trouble-
shooting issues specific to the Mac, including 
how to handle, check, and erase a DigiDrive and 
how to resolve basic problems that might occur 
during installation and operation.

◆ Chapter 6, “DigiDrive Management for 
Windows NT and Windows 2000” covers man-
agement and troubleshooting issues specific to 
Windows, including how to create partitions, 
create logical drives, how to format logical 
drives, and how to resolve basic problems that 
might occur during installation and operation.

◆ Appendix A, “Specifications”, provides physi-
cal dimension, environmental, power, and 
power cord specifications for the DigiDrive.

◆ Appendix B, “SCSI Cables and Terminators”, 
provides detailed information on the type of ca-
bles and terminators that can be used with the 
DigiDrive.

If You Need Help

If you are having trouble setting up and configuring 
the DigiDrive:

1  Retry the action, carefully following the in-
structions given for that task in this guide.

2  Check the documentation that came with 
your hardware for maintenance or hardware-re-
lated issues.
Chapter 1: Using This Guide 1
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3  Digidesign has both product information and 
technical support on-line via the World Wide 
Web. In addition, there are many user forums 
which Digidesign encourages, but does not 
sponsor. For the most current, accurate informa-
tion about Digidesign products, please browse 
Digidesign-sponsored forums at the Digidesign 
Web site (www.digidesign.com).

4  See the additional technical resources on the 
web at:

http://www.digidesign.com/support/techsup-
port.html

Related Information

The following documents provide additional in-
formation that might be useful when configur-
ing the DigiDrive:

◆ DigiDrive Utilities Read Me
DigiDrive Guide



         
chapter 2

Overview
The Digidesign DigiDrive uses industry-stan-
dard ultra wide SCSI-2 Ultra160 drives that can 
be run in LVD or Single-Ended mode, and are 
optimized for use with Digidesign’s video and 
audio applications. With its fast operating speed 
(10,000 rpm) and its QuietDrive sound-absorb-
ing enclosure, the DigiDrive is among the fastest 
and quietest drives available today. 

Multiple drives can be stacked on top of one an-
other to minimize desk-space requirements. A 
rack-mounting option enables the DigiDrive to 
be mounted in industry-standard racks. 

The internal drives have a 3 1/2-inch form fac-
tor. The SCSI-2 compatible drives transfer data 
on a 16-bit data bus. The drives also support 
8-bit data transfers for compatibility with nar-
row SCSI buses, like the Macintosh built-in SCSI 
bus. The drive enclosure provides the cooling, 
the power, and the cabling connections.
This chapter provides the following information 
on the DigiDrive:

• Controls and Indicators

• Rack-Mounting Option

• Handling the DigiDrive

• SCSI Configuration Requirements

Controls and Indicators
The Digidesign DigiDrive has the controls and 
indicators on the front, and the connectors on 
the back. These controls and indicators let you 
configure the drive and provide the operating 
status.

Front Panel

The DigiDrive front panel is shown in Figure 1. 
You can use the Digidesign product identifica-
tion label to determine the capacity and type of 
drive. The power switch turns the drive’s inter-
Chapter 2: Overview 3
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nal power supply on and off. The ventilation 
openings provide airflow for the drive while it is 
operating. Make sure you do not block these 
openings and that you keep them clear of dust.

Three light emitting diodes (LEDs) indicate the 
status of the drive. The SCSI ID switch provides 
the method for setting the drive’s SCSI ID. De-
tailed descriptions of the LEDs are provided in 
Table 1.

Figure 1.  DigiDrive front panel

Table 1.  DigiDrive LEDs

LED Function

Power 
LED

The LED (green) is on when the drive is 
turned on. 

Activity 
LED

The LED (yellow) is on when the drive is 
turned on and then flickers as data is 
transferred to and from the drive.

Thermal 
LED

The LED (red) is on when the thermal 
overload circuitry on the board senses 
that the temperature inside the DigiD-
rive is too high. The LED lights for the 
following reasons:
• Airflow through the drive is blocked.
• The internal fan has failed.
• Outside ambient temperature is too 

hot.
Warning: 
Operating the DigiDrive  for extended 
periods of time with the thermal indica-
tor on reduces the life expectancy of 
the drive.

2
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Back Panel

The DigiDrive back panel has two SCSI connec-
tors and a power connector (see Figure 2). The 
SCSI connectors are for attaching SCSI cables or 
a SCSI terminator to the drive. An internal fan 
pushes air through the enclosure, from front to 
back, to cool the drive. The power connector is 
where you attach the power cord. 

Rack-Mounting Option
Digidesign offers an optional rack-mounting kit 
(Digidesign model number MH163) that allows 
you to mount a pair of DigiDrive enclosures in a 
rack. The kit supports two drives mounted side-
by-side, occupying two rack units in an indus-
try-standard rack. 

The DigiDrive is designed so that all of the con-
trols and indicators are accessible when 
mounted. Instructions for mounting the drives 
are included with the kit.

Figure 2.  DigiDrive back panel
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Handling the DigiDrive
You need to use reasonable care when you han-
dle a DigiDrive. Though the drive is ruggedly 
constructed, it has delicate internal mechanisms 
that can be damaged when handled in an incor-
rect manner. The following lists contain tips for 
handling and caring for the drives attached to 
your Digidesign system.

When the drives are not operating:

◆ Be careful not to drop a drive as you move it 
from one system to another.

◆ Keep the area around the drives free of dust 
and dirt.

◆ When you stack the drives, limit the stack 
height to four drives. This helps to prevent the 
stack from tipping over.

When the drives are operating:

◆ Do not shake or jar the drive enclosures. This 
can damage the read/write heads or the mag-
netic coating on the drive platters.

◆ Do not turn off the power to a drive while you 
can see the icon on a Macintosh desktop. This 
can cause directory structure problems and 
might create incomplete files.

Do not open a DigiDrive enclosure; there 
are no user-repairable parts inside. Opening 
the enclosure voids your Digidesign war-
ranty and prevents you from having the 
drive mechanism repaired without charge.
◆ Do not turn off the power to a drive while an 
application is reading data from or writing data 
to the drive. This can cause directory structure 
problems and might create incomplete files.

◆ Never disconnect SCSI cables or the SCSI ter-
minator while the Digidesign system and the 
drives are running. Shut down the system and 
turn off the drives before making cabling 
changes.

SCSI Configuration 
Requirements
As you add a DigiDrive to your Digidesign sys-
tem, you need to be aware of the Digidesign re-
quirements for installing the drives correctly. 
These requirements include:

◆ Laying out drives on the SCSI bus

◆ Cabling the drives

◆ Setting the drive SCSI IDs

◆ Terminating the SCSI bus

The following sections list the requirements for 
installing a DigiDrive and configuring the SCSI 
bus. If you fail to meet all of the requirements, 
your DigiDrive and Digidesign software might 
not function properly. 
Chapter 2: Overview 5
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Cables

Use only high-quality LVD SCSI cables when 
you are attaching a DigiDrive to the SCSI bus on 
your Digidesign system.

The DigiDrive includes a 30" Avid SCSI LVD ca-
ble that meets all requirements for optimal per-
formance. This cable is backward-compatible 
and also operates in single-ended fast, wide 
mode.

SCSI IDs

Your Digidesign system identifies the DigiDrives 
connected on the SCSI bus by the drive’s as-
signed SCSI ID. When you are assigning SCSI 
IDs to the drives, remember the following:

◆ Each SCSI ID on a SCSI bus must be unique.

◆ Each device on each SCSI bus, including the 
system SCSI accelerator board, has its own SCSI 
ID. 

◆ SCSI ID 7 is reserved for each SCSI accelerator 
board in your system. You must never assign 
SCSI ID 7 to a DigiDrive.

◆ Narrow drives can only use SCSI IDs 0 
through 6.

◆ Wide drives, such as the DigiDrive, can use 
SCSI IDs 0 through 6 and 8 through 15. 

For more information on SCSI cables, 
see Appendix B.
DigiDrive Guide
SCSI ID Conflicts

When you add a new DigiDrive to your system, 
always check which SCSI IDs are currently in 
use. Assigning duplicate SCSI IDs causes prob-
lems such as system errors, the drive not appear-
ing on the desktop, multiple copies of the same 
drive appearing on the desktop, possible data 
corruption, or system startup failures.

Termination

You need to connect a SCSI LVD terminator to 
the last drive on each SCSI bus. Make sure to use 
only the highest quality SCSI terminators to en-
sure data integrity. 

The DigiDrive comes with Avid's patented 68-
pin multi-mode (LVD or Single-Ended) termina-
tor for optimal data integrity across the SCSI 
chain. The Avid LVD terminator detects the 
SCSI bus mode. The LED on the end of the ter-
minator is green when the SCSI bus is in LVD 
mode, and amber when the SCSI bus is in single-
ended fast, wide mode.

You need to connect an ultra, wide-to-narrow 
SCSI adapter to change from 68-pin cabling to 
50-pin cabling. The adapter terminates the un-
used lines to help prevent any SCSI bus prob-
lems.

Mixing an LVD drive with a single-ended wide 
and/or narrow drive on an LVD bus causes the 
bus to default to single-ended mode. When you 
mix drive types, cable length restrictions for sin-
gle-ended SCSI chains apply. 

For more information on SCSI terminators, 
see Appendix B.



   
Mixing Wide and Narrow Drives on the Same SCSI Bus
Figure 3.  Mixed Drive Layout
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You can mix the DigiDrive and other wide and 
narrow drives. This allows you to continue us-
ing existing narrow drives as you expand your 
system’s storage capability. When mixing wide 
drives and narrow drives on the same SCSI bus, 
remember the following:

◆ You must place the wide drives physically on 
the SCSI bus before the narrow drives (see 
Figure 3). 
◆ Always use a 68-pin to 68-pin cable and a 
wide-to-narrow terminating adapter (68-pin to 
50-pin) for the connection between the last 
wide drive and the first narrow drive (see 
Figure 3). The adapter terminates unused data 
lines in the cable to ensure data integrity on the 
SCSI bus.

◆ PCI-based SCSI buses that contain a mixture 
of wide and narrow DigiDrives can have up to 
eight drives on the SCSI bus.
Chapter 2: Overview 7
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chapter 3

Installation
The following sections describe how to connect 
a DigiDrive to your Digidesign system.

Before You Begin

Before you begin to install a DigiDrive:

■ Check the contents of the DigiDrive kit 
against the packing label on the outside of the 
shipping box to confirm that you have received 
all the parts.

■ Check for available SCSI IDs on the Digide-
sign SCSI bus.

DigiDrive Components

The DigiDrive package contains:

• DigiDrive

• 30-inch 68-pin to 68-pin SCSI LVD cable

• Avid multi-mode 68-pin terminator

• Utilities CD ROM

• Power cable

• Drive-stacking brackets

• Registration card
              Installing Software  

The Utilities CD-ROM that comes with DigiD-
rive contains utilities that will performance-
tune your DigiDrive and perform diagnostic 
tests when necessary. To install the software, 
drag and drop the DigiDrive Utilities folder to 
your system drive. For your convenience, we 
suggest you drag it to your Digidesign software 
folder.

 

Installing a DigiDrive

 

When you add a new DigiDrive to your Digide-
sign system, the DigiDrive is connected to one 
of the SCSI buses in the system. In some cases, 
you might need to disconnect some or all of the 
drives on a SCSI bus when you add a new drive. 
Use the instructions in the following sections to 
install the DigiDrive.

 

Refer to the DigiDrive Utilities Read Me doc-
ument on the DigiDrive Utilities CD-ROM 
for complete instructions on the use of your 
DigiDrive Utilities.
Chapter 3: Installation 9
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Powering Down the Digidesign 
System

Before you begin to install the DigiDrive, power 
down the system:

1  Do one of the following:

• If you have a Macintosh operating system, 
choose Shut Down from the Special menu. 

• If you have a Windows operating system, se-
lect Shut Down from the Start button. Select 
“Shut down the computer?” from the Shut 
Down Windows dialog box and click Yes. 

2  Turn off power to all peripherals connected to 
the Digidesign system.

Stacking the DigiDrive

When you have more than one DigiDrive you 
might want to stack the drives so they take up a 
minimal amount of desk space. The DigiDrive 
has patented interlock stacking brackets at-
tached to the side that are designed for stacking. 

The interlock stacking brackets provide three 
methods of stacking.

Gravity Stacking

Gravity stacking allows you to place one drive 
on top of another. An impression in the base of 
the interlock stacking brackets increases the sta-
bility when compared to just having the enclo-
sures stacked without the bracket. This method 
is only recommended when temporarily mov-
ing the drive from one system to another.

Temporary Interlock 

Temporary interlock provides a more secure 
method of stacking the DigiDrive enclosures. 
Grooves in the interlock stacking brackets stabi-
lize the drives. An indentation in each groove 
settles the drive in the correct position. 
DigiDrive Guide
            

To temporarily interlock the drives:

1  Place the first (bottom) DigiDrive on a stable 
surface.

2  Position a second DigiDrive slightly over and 
behind the first drive.

3  Slide the top DigiDrive forward so the slots in 
the four top drive interlock stacking brackets 
slide over the four tabs on the bottom drive in-
terlock stacking brackets (see Figure 4).

Permanent Interlock

Permanent interlock is an enduring way of 
stacking the drives. After interlocking the drives, 
a locking plate is positioned so that the top and 
bottom drives are secured in place. 

To permanently interlock the drives:

1  Perform steps 1, 2, and 3 as described in “Tem-
porary Interlock” on page 10.

2  Remove the top locking plate screw on both 
sides of each drive (see Figure 5).

3  Loosen the bottom locking plate screw on 
both sides of each drive.

Figure 4.  Stacking the DigiDrive
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4  Swing the locking plate on each side of the 
bottom drive 90 degrees (to a horizontal posi-
tion) and tighten the locking plate screw (see 
Figure 6).

5  Swing the locking plate on the top drive 180 
degrees so that the upper hole in the top locking 
plate aligns with the upper hole in the bottom 
drive.

6  Replace the screw into the top hole in the bot-
tom drive so that the top and bottom drives are 
secured to each other (see Figure 7).

7  Replace the remaining screw into the top hole 
in the top drive.

Figure 5.  DigiDrive Locking Plate

Figure 6.  Bottom Drive Locking Plate
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8  Repeat steps 5 through 7 for the other side of 
the top drive.

9  Repeat this entire procedure if stacking a third 
and fourth drive.

When more than four drives are used, consider 
creating two drive stacks. In order to prevent the 
stack from toppling over, be sure to stack the 
drives with the largest units on the bottom.

If you have the dual-channel SCSI accelerator 
board or two single-channel SCSI accelerator 
boards, you might want to arrange the drives in 
two separate stacks; one stack for each SCSI 
chain. Attach the drives to the system one group 
at a time.

A

Figure 7.  Secured DigiDrive Enclosures
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Connecting DigiDrives

To connect an external SCSI drive to your 
computer:

1  Be sure that power to both the computer and 
hard drive is off.

2  Connect the SCSI drives to your computer 
with their accompanying SCSI cables. 

Connecting a SCSI cable to the SCSI port

to external 
SCSI hard drive
DigiDrive Guide
Always use high-quality cables. Additionally, 
use the shortest possible SCSI cables to make the 
best possible connection—if you are using a sin-
gle-ended accelerator card, your total SCSI cable 
length should never exceed 3 meters. If you are 
running an LVD accelerator, your total SCSI ca-
ble length can run as long as 12 meters.

3  Secure the SCSI cables in place with their 
thumbscrews. Loose SCSI cables can cause prob-
lems with your system.

4  Connect any other drives by daisy- chaining 
from one drive to another. Cable lengths on the 
computer SCSI chain should be kept to a mini-
mum. Use the shortest length possible. The 
overall SCSI chain length should not exceed 3 
meters. 

5  Verify that the last SCSI device connected is 
properly terminated (see the section that fol-
lows regarding termination).

6  Attach a power cable to your hard drives. 

Your hard drives should now be properly con-
nected and ready for use.

Connecting an external SCSI hard drive

SCSI Hard Drive

to computer’s
SCSI port

SCSI Terminator

To computer’s SCSI host
bus adapter



Connecting Only DigiDrive 
Enclosures

The following procedure explains how to con-
nect a DigiDrive. Stack the drives before connect-
ing any cables and turning the drives on.

To connect DigiDrive enclosures:

1  Attach the 68-pin SCSI connector from the 
computer's SCSI host bus adapter to either SCSI 
connector on the DigiDrive 

2  If you have more than one DigiDrive, locate 
the SCSI cable with 68-pin connectors on both 
ends in the next drive kit.

To avoid bending pins, make sure the 68-
pin cable is perpendicular to the back panel 
and properly aligned before inserting.

Figure 8.  SCSI Cable to First DigiDrive Connection

DigiDrive

68-pin SCSI cable from computer's SCSI 
host bus adapter or other drives
3  Attach one end of the cable to the remaining 
SCSI connector on the first DigiDrive in the 
drive stack (see Figure 9). Secure the cable by us-
ing the thumbscrews that are part of the cable 
connector.

4  Repeat steps 2 through 5 until you have all the 
drives connected.

5  Attach the other end to either SCSI connector 
on the next DigiDrive in the drive stack. Secure 
the cable by using the thumbscrews that are part 
of the cable connector.

Figure 9.  Additional DigiDrive Connection

DigiDrive

68- pin to 68-pin 
15-inch SCSI cable

68-pin SCSI cable from computer's SCSI 
host bus adapter or other drives
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6  Attach the SCSI terminator to the remaining 
SCSI connector on the last DigiDrive in the drive 
stack (see Figure 10). Secure the terminator by 
using the thumbscrews that are part of the ter-
minator.

7  Attach an ac power cord to the ac power con-
nector on the back of each DigiDrive.

8  Plug the ac power cords into a power strip.

9  If your system came with the dual-channel 
board, repeat steps 1 through 8 to attach a sec-
ond SCSI chain to the system.

Connecting Wide and Narrow SCSI 
Drives

The following procedure explains how to con-
nect a mix of wide and narrow drives. 

To connect wide and narrow drives:

1  Attach the 68-pin SCSI connector on the sys-
tem cable to either SCSI connector on the 
DigiDrive (see Figure 11). Secure the cable by us-
ing the thumbscrews that are part of the cable 
connector.

Figure 10.  Ultra, Wide SCSI Terminator Connection

To avoid bending pins, make sure the 68-
pin cable is perpendicular to the back panel 
and properly aligned before inserting.

DigiDrive
Ultra, wide SCSI terminator

68-pin SCSI cable from computer's SCSI 
host bus adapter or other drives
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2  

 

If you are connecting a wide drive, locate the 
SCSI cable with 68-pin connectors on both ends 
in the drive kit.

 

3  

 

Attach one end of the cable to the remaining 
SCSI connector on the DigiDrive in the drive 
stack (see Figure 12). Secure the cable by using 
the thumbscrews that are part of the cable con-
nector.    

Figure 11.  SCSI Cable to DigiDrive Connection

Figure 12.  Additional Wide Drive Connection

DigiDrive

68-pin SCSI cable from computer's 
SCSI host bus adapter

4

DigiDrive

Wide drive

68- pin to 68-pin 
15-inch SCSI cable

68-pin SCSI cable from computer's SCSI 
host bus adapter or other drives



4  Attach the other end to the bottom connector 
on the Wide drive in the drive stack. Secure the 
cable by using the thumbscrews that are part of 
the cable connector.

5  Repeat steps 2 through 4 until you have all the 
wide drives connected.

6  Locate a SCSI cable with 68-pin connectors on 
both ends in the drive kit.

7  Attach one end of the cable to the remaining 
connector on the last (top) wide drive in the 
drive stack (see Figure 12). Secure the cable by 
using the thumbscrews that are part of the cable 
connector.

8  Locate an ultra, wide-to-narrow SCSI adapter. 
The adapter has a 68-pin female connector on 
one end and a 50-pin Centronics® connector on 
the other end.

9  Attach the wide-to-narrow SCSI adapter to the 
first (bottom) narrow drive (see Figure 13). Se-
cure the adapter by using the bail-latches that 
are part of the narrow drive.

Refer to the DigiDrive Utilities Read Me doc-
ument on the DigiDrive Utilities CD-ROM 
for complete instructions on the use of your 
DigiDrive Utilities.

Figure 13.  SCSI Cable to Narrow Drive Connection

0
+   

68- pin SCSI connector

Narrow Drive

Wide-to-narrow
SCSI adapter

Bail-latches

 

                 

10  

 

If you have more than one narrow drive, lo-
cate the SCSI cable with 50-pin Centronics con-
nectors on both ends.

 

11  

 

Attach one end of the 50-pin cable to the top 
connector on the first narrow drive (see 
Figure 14). Secure the cable by using the bail-
latches that are part of the narrow drive.

 

12  

 

Attach the other end of the narrow SCSI ca-
ble to the bottom connector on the next narrow 
drive. Secure the cable by using the bail-latches 
that are part of the narrow drive.

 13   Repeat steps 10 through 12 until you have 
connected all the drives.

 

14  

 

Locate the ultra, narrow 50-pin SCSI termi-
nator. 

 

15  

 

Attach the SCSI terminator to the top con-
nector on the top narrow drive in the drive stack 
(see Figure 15). Secure the terminator by using 
the bail-latches that are part of the DigiDrive.

 

16  

 

Attach an ac power cord to the ac power con-
nector on the back of each drive.

 

17  

 

Plug the ac power cords into a power strip.

  

Figure 14.  Additional Narrow Drive Connection
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18  If your system came with the dual-channel 
board, repeat steps 1 through 17 to attach the 
second stack of drives to the system.

Determining SCSI IDs
You must consider the type of system the drives 
are attached to when determining the SCSI ID 
for the drive. Macintosh systems have an inter-
nal SCSI bus, an external SCSI bus, and a PCI-
based SCSI board. Windows systems may have 
support for SCSI integrated into the mother-
board (e.g. IBM Intellistation) or provided by 
one or more PCI-based expansion cards. 

Digidesign recommends that you set the SCSI 
IDs for the devices on each SCSI bus in sequen-
tial order, that is, starting with the device at-
tached closest to the Digidesign system as ID 0 
(see Figure 16).

Figure 15.  Ultra, Narrow SCSI Terminator Connection

Do not set the SCSI ID for any drive on any 
SCSI bus to SCSI ID 7. This SCSI ID is re-
served for the SCSI accelerator board to 
which the drive is attached. Setting a drive 
to the same SCSI ID as the SCSI accelerator 
board can prevent the drive from mounting 
on the desktop, or prevent your Digidesign 
system from booting correctly.

0
+   

Narrow

50- pin SCSI connector

Ultra, narrow SCSI terminator

Drive
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SCSI IDs on Macintosh Systems

 

For each SCSI hard drive you connect to the 
Macintosh operating system, you must assign a 
SCSI ID so the system can find and access the 
drive. When you are setting the SCSI IDs, re-
member the following:

 

◆

 

The Macintosh system might have several 
SCSI buses: a built-in internal SCSI bus, a built-
in external SCSI bus (on PCI-based systems), and 
one or more Digidesign SCSI buses that are 
added using SCSI accelerator boards. The dual-
channel SCSI accelerator board adds two SCSI 
buses to the Digidesign system.

 

◆

 

You can attach six additional narrow SCSI de-
vices to the external built-in SCSI bus on the 
Digidesign systems. This SCSI bus has its own 
set of unique SCSI IDs from 0 through 6. 

  

Figure 16.  Setting SCSI IDs

Connect all 68-pin, wide SCSI devices on a 
SCSI bus before connecting the 50-pin, nar-
row SCSI devices. All narrow drives must 
use SCSI IDs less than 7.
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◆

 

Each PCI-based SCSI bus has its own set of 
unique SCSI IDs from 0 through 6 and 8 
through 15.

• If you are connecting only DigiDrive enclo-
sures to the SCSI bus, use any of the avail-
able SCSI IDs from 0 through 6 and 8 
through 15.

• If you are connecting a mix of wide and 
narrow drives to the SCSI bus, use SCSI IDs 
0 through 6 for the narrow drives and SCSI 
IDs 8 through 15 for the wide drives.

 

◆

 

You cannot have two SCSI drives with the 
same SCSI ID on the same SCSI bus.

 

SCSI IDs on Windows Systems

 

For each SCSI hard drive you connect to the 
Windows operating system, you must assign a 
SCSI ID so the system can find and access the 
drive. When you are setting the SCSI IDs, re-
member the following:

 

◆

 

Each Digidesign PCI-based SCSI bus has its 
own set of unique SCSI IDs from 0 through 6 
and 8 through 15 (for a maximum of eight 
drives).

• If you are connecting only DigiDrive enclo-
sures to the SCSI bus, use any of the avail-
able SCSI IDs from 0 through 6 and 8 
through 15.

• If you are connecting a mix of wide and 
narrow drives to the SCSI bus, use SCSI IDs 
0 through 6 for the narrow drives and SCSI 
IDs 8 through 15 for the wide drives.

 

◆

 

You cannot have two SCSI drives with the 
same SCSI ID on the same SCSI bus.

         
Setting the DigiDrive SCSI ID

To set a DigiDrive SCSI ID:

1  Locate the SCSI ID switch on the front of the 
DigiDrive (see Figure 17).

2  Set the SCSI ID to an available SCSI ID on the 
SCSI bus by using the SCSI ID switch (see 
Figure 18). The current SCSI ID number appears 
in the window in the middle of the switch. 

• Press the top button to decrement the SCSI 
ID. 

• Press the bottom button to increment the 
SCSI ID. 

Figure 17.  DigiDrive SCSI ID Switch Location

Be sure the drive power is off when changing 
the SCSI ID switch. When the drive is 
turned on it will read the new SCSI ID.

Figure 18.  DigiDrive SCSI ID Switch
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There are two SCSI ID switch versions used with 
the DigiDrive. One version uses the numbers 0 
through 15, and the other version uses the num-
bers 0 through 9 and the letters A through F. Use 
the table below to associate the letters A through 
F with a SCSI ID number.

 
Numbers Associated with SCSI Switch Letters

 

Switch Letter SCSI ID Number

 

A 10

B 11

C 12

D 13

E 14

F 15

 

When setting the SCSI ID for a drive other 
than a DigiDrive, see the documentation 
that came with that drive.
DigiDrive Guide



   

chapter 4

 SCSI Performance Guidelines                 
SCSI Performance Guidelines

Pro Tools systems have strict hard drive require-
ments. The recording and playback perfor-
mance of your system depends on several fac-
tors.

Factors affecting system performance:

◆ Hard drive performance. The faster the drive’s 
seek time, the better. The data transfer rate re-
quired for 32 track, 24-bit performance (at a 
sample rate of 44.1 kHz) is 4.04 MB per second 
of sustained throughput. This rate must be re-
flected in the performance of one or more of the 
drives and SCSI subsystems in your computer to 
achieve this level of performance.

◆ CPU speed. The faster the CPU, the better. 
Overall system performance can affect track 
count. 

◆ Size of your DAE Playback Buffer. See the 
Pro Tools System Installation Guide for an expla-
nation of DAE Playback Buffer size and its effect 
on system performance.

◆ Edit density (the number of edits per second) 
affects the number of different files that a drive 
must seek. Sessions with high edit density are 
more demanding on hard drives than sessions 
with lower edit density. For this reason, drive 

Make sure to run DigiDrive Tuner to opti-
mize your drive for your Digidesign system.
performance may depend on the session you are 
playing. While there is no specific definition of 
high or low edit density, most Pro Tools users 
will work with low to moderate edit density ses-
sions. However, extensive use of crossfades, or 
certain processing like Beat Detective can create 
high levels of edit density in any session.

If you suspect that you are receiving poor drive 
performance due to high edit density, use the 
Consolidate command for heavily edited tracks. 
This will reduce the number of seeks required.

In general, you can obtain the following perfor-
mance goals with the following setups:

To achieve up to 16 simultaneous tracks of 16- or 
24-bit audio with heavy edit density, or 32 tracks 
with low to moderate edit density, you will need:

◆ One or more Digidesign-approved hard drives 
connected to your SCSI adapter card or built-in 
SCSI ports. If your sessions have high-density 
edits (for example, 3 edits per second across all 
tracks, all with crossfades), you will need to dis-
tribute your audio files over more than one hard 
drive to allow for increased demand on drive 
seek capability.
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To achieve up to 32 simultaneous tracks of 16- or 
24-bit audio with high edit density, or 64 tracks 
with low to moderate edit density you will need:

◆ Two or more Digidesign-approved hard drives 
connected to your SCSI adapter card or built-in 
SCSI ports. If you use a dual-channel SCSI host 
adapter card, equally allocate audio files to 
drives connected to each of the two busses on 
the card for optimal performance. 

For details on allocation of tracks to drives, see 
the section on Recording to Multiple Hard 
Drives in the Pro Tools Reference Guide. 

Additional Hard Drive Performance Tips:

Use at least two drives You can improve perfor-
mance by allocating audio files between two or 
more hard drives. It is best to use drives that 
have similar performance characteristics.

Minimize SCSI cable length The maximum cable 
length that can be used on a “wide” single-
ended SCSI bus is 3 meters if you are using fewer 
than four devices, or 1.5 meters if you are using 
four or more devices. Please note that cable 
length includes the cabling inside the drive en-
closures themselves—which can be up to 12 
inches in length. If you are running the DigiD-
rive in LVD mode, the maximum SCSI cable 
length is 12 meters.

Avoid distributing audio files within a ses-
sion over different partitions on the same 
drive, as this will slow drive performance.
DigiDrive Guide
            



   

chapter 5

 DigiDrive Management for Mac OS                     
To keep your DigiDrive and other hard drives on 
your Macintosh operating system in peak oper-
ating condition, you should perform mainte-
nance operations and checks on a regular basis.

This chapter contains the following sections:

◆ Checking DigiDrives

◆ Initializing DigiDrives

◆ Troubleshooting

Checking DigiDrives
Many drive problems are not hardware related, 
but are instead problems with the file system 
written on the drive. The file system consists of 
data structures that hold critical information 
about the files stored on your drive. Some of 
these data structures allow your drive to be rec-
ognized as a Macintosh volume.

Using utilities such as Disk First Aid™ and 
Norton Disk Doctor™ helps to maintain the file 
system and its data structures. Digidesign rec-
ommends periodic use of these utilities on any 
DigiDrive and other hard drives, as well as your 
Macintosh internal drive, to ensure a healthy 
file system.
File system errors tend to grow over time. They 
should be fixed as soon as possible after discov-
ery. File system errors are generally caused by 
system crashes, improper system shutdowns, 
and power failures. They should not be inter-
preted as a precursor to a mechanical drive fail-
ure.

The following list contains examples of some 
common file system structure errors that 
Norton Disk Doctor can diagnose and, in most 
cases, fix without damaging data (media files or 
project data):

◆ Master directory block errors

◆ Alternate master directory block errors

◆ Leaf node errors

◆ Header node errors

◆ Volume bit map errors

◆ Files with bad creation dates

Every drive has a directory or index that informs 
the system where files reside. If the directory be-
comes damaged or corrupted, the system will 
not be able to locate the files.
Chapter 5: DigiDrive Management for Mac OS 21
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Using Disk First Aid

Disk First Aid is a drive directory structure repair 
tool that is supplied with each system by Apple 
Computer, Inc. This tool can find and repair 
many basic directory structure problems to help 
keep your drives functioning properly. 

You should use Disk First Aid when your system 
is reporting drive errors or when files on the 
drive cannot be opened and used by Digidesign 
software.

You can find a copy of Disk First Aid in one of 
the following locations:

◆ The Utilities folder on the system drive

◆ The system software CD-ROM that came with 
your system

Repairing DigiDrives with Disk First Aid

To repair a DigiDrive:

1  Open the Utilities folder on the Digidesign (or 
system) drive.

2  Double-click the Disk First Aid icon to start 
the application. The Disk First Aid window 
opens (Figure 19). This window contains all the 
necessary controls for you to run Disk First Aid.

You should run Disk First Aid regularly as a 
proactive method of avoiding drive prob-
lems.

Figure 19.  Disk First Aid—controls
DigiDrive Guide
               

3  

 

Select the drive you want to verify and repair 
by clicking on the drive icon in the Drive Selec-
tion window. An alert box opens if you are 
checking a drive with open files or a shared drive 
(Figure 20). You can only verify these drives 
while they are not in use. Click OK to close the 
alert box.  

4  

 

Verify and repair the selected drive by clicking 
the Repair button. Disk First Aid scans the direc-
tory structures, reports any problems, repairs 
the selected drive (if possible), and reports the 
results.

 

5  

 

If Disk First Aid reports that the selected drive 
cannot be verified or repaired, follow the steps 
in “If Drive Status Cannot Be Verified” on 
page 22.

 

6  

 

Choose Quit from the File menu when you are 
finished.

 

If Drive Status Cannot Be Verified

 

If Disk First Aid is unable to verify or repair the 
DigiDrive:

 

1  

 

If possible, copy all media files and other data 
files to another drive.

 

2  

 

Try using Norton Disk Doctor to repair the 
drive. See “Using Norton Disk Doctor” on 
page 23.

   

Figure 20.  Disk Repair failure notification



         
If you are still experiencing problems or are un-
able to repair the drive, contact Digidesign 
Technical Support for additional assistance.

Using Norton Disk Doctor

Norton Disk Doctor is a third-party application 
for diagnosing and repairing drive problems. 
Norton Disk Doctor provides more comprehen-
sive coverage of drive problems than Disk First 
Aid, and can repair directory structure and file 
problems that Disk First Aid cannot repair.

Load Norton Utilities® onto one or more of the 
drives on your system before you continue with 
the following sections. You might want to load 
Norton Utilities into the Utilities folder with 
Disk First Aid for convenience.

Repairing DigiDrives with Norton Disk 
Doctor

To repair a DigiDrive:

1  Open the Norton Utilities folder on your 
Digidesign system.

2  Double-click the Norton Utilities icon to start 
the application. The Norton Utilities Main 
menu appears (Figure 21).

3  Choose Norton Disk Doctor from the Norton 
Utilities Main menu. The Norton Disk Doctor 
window opens.

You should perform a custom installation 
of the Norton Utilities to load only the Re-
pair and Recovery utilities and the Startup 
Disk Builder. Other functions in the Norton 
Utilities can cause conflicts with Digidesign 
software. 

You should run Norton Disk Doctor regu-
larly as a proactive method of avoiding 
drive problems.
                

4  

 

Follow the instructions in the 

 

Using the Norton 
Utilities

 

 manual for drive repair and recovery. At-
tempt to fix all of the problems noted by Norton 
Disk Doctor as it is running. Follow any special 
instructions or recommendations that Norton 
Disk Doctor provides.

5  When Norton Disk Doctor is finished, a dialog 
box appears. Click Show Report to see a listing 
of the problems that were found with the drive, 
or click Done to return to the Norton Disk Doc-
tor window.

6  Repeat steps 4 and 5 to make sure the prob-
lems were fixed.

7  Choose Quit from the File menu when you are 
finished.

Figure 21.  Norton Utilities Main menu

After using Norton Disk Doctor and Disk 
First Aid for drive repair and recovery, 
Digidesign recommends that you backup 
your data and reinitialize your drive as soon 
as possible.
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Initializing DigiDrives
Occasionally, you might want to initialize the 
drives on your Digidesign system to remove all 
the data that is on them. Initializing re-creates 
the partition map and directory structure, im-
proving overall drive performance. It is best to 
initialize drives when you are between projects, 
or when the media files and other data on the 
drives are no longer needed.

For more information on initializing drives, see 
the ATTO ExpressPro-Tools manual. 

Troubleshooting
Occasionally, you might have problems with a 
DigiDrive that you can repair on your own. The 
following sections present several scenarios and 
steps to take to repair them.

DigiDrive Does Not Turn On

When a DigiDrive does not turn on after you 
press the power switch, you should do the fol-
lowing:

1  Make sure the ac power cord is securely con-
nected to the drive enclosure.

2  Make sure the drive is plugged into a power 
strip or a wall outlet.

3  If the drive is plugged into a power strip, make 
sure the power strip is plugged into a wall outlet 
and that the power strip is turned on.

After you turn on the drive, the green power 
LED on the front of the drive is lit.

Initializing a drive destroys all the data on 
the drive. Make sure you back up all the crit-
ical data on the drive to tape or another 
drive before you initialize the drive.
DigiDrive Guide
DigiDrive Does Not Appear on the 
Desktop

When a DigiDrive does not appear on the desktop:

1  Make sure the drive turns on. Follow the in-
structions in “DigiDrive Does Not Turn On” on 
page 24 if the drive does not turn on.

2  Make sure all the cables in the SCSI bus are 
properly connected and secured in place by 
thumbscrews for wide drives or bail-latches for 
narrow drives. See Chapter 3 for cable and setup 
information.

3  Make sure each SCSI bus is properly termi-
nated. See Chapter 3 and Appendix B for infor-
mation on the correct terminator to use with 
the drive configurations on your system.

4  Make sure each drive on a SCSI bus has a 
unique SCSI ID. If you have drives with dupli-
cate IDs, one or both of the drives might not ap-
pear on the desktop. See “SCSI IDs on 
Macintosh Systems” on page 16 for information 
on how to set SCSI IDs. Turn the drive off and 
then on to ensure that the new SCSI ID is set.

5  After making sure the drive is on, making any 
cabling changes, changing drive termination, or 
changing SCSI IDs, restart the Digidesign system 
for the changes to take effect.

Before making any changes to DigiDrive ca-
bling or termination, make sure you shut 
down the Digidesign system and turn off all 
of the drives on the SCSI bus.



DigiDrive Produces Errors

When a DigiDrive is producing errors or is acting 
erratically:

1  Run Disk First Aid to repair any directory 
problems.

2  Run Norton Disk Doctor to fix any bad block, 
folder, and file problems.

3  Use Norton Utilities to rebuild the drive’s 
desktop (the files that maintain the record of 
what is on the drive).

4  Contact Digidesign Technical Support if you 
need additional assistance.

System Fails to Boot

When the system fails to boot, you should do 
the following:

1  Make sure all Digidesign cards and SCSI accel-
erator cards are properly seated.

2  Check that all SCSI devices on the bus have a 
unique SCSI ID. Duplicate SCSI IDs cause system 
problems.

3  Make sure all SCSI cables are properly con-
nected.

4  Check that the SCSI bus is properly termi-
nated, as described in Chapter 3.

5  If the system still does not boot or if it hangs, 
disconnect all SCSI drives and try to boot the 
system. If the system boots, either a drive, a ca-
ble, or the SCSI terminator might be defective. 

6  See the setup guide that came with your sys-
tem for additional troubleshooting informa-
tion.

7  Contact Digidesign Technical Support if you 
need additional assistance.
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chapter 6

DigiDrive Management for Windows NT and 
Windows 2000
To use your DigiDrive on a computer running a 
Windows operating system, you need to format 
and partition the drive properly. Once this has 
been accomplished, you need to keep your 
DigiDrive in peak operating condition by per-
forming maintenance operations and checks on 
a regular basis. 

This chapter contains the following sections:

◆ Windows Drive Subsystem Overview

◆ Creating Primary Partitions

◆ Formatting Partitions

◆ Creating an Emergency Repair Disk

◆ Saving the Disk Configuration

◆ Keeping Your Hard Drive Tuned Up

◆ Troubleshooting
Chapter 6: Di
Windows Drive Subsystem 
Overview
Windows allows you to create multiple parti-
tions on a single drive as a way to manage 
projects and files. This section helps to clarify 
the function of partitioning a drive and other 
features related to drive performance. 

The following list provides some information 
concerning partitions and disk devices on Win-
dows systems:

◆ You can partition your drive as one primary 
partition, having the partition represented by a 
drive letter (Figure 22). 

Digidesign does not support extended parti-
tions or logical drives on the DigiDrives.

Figure 22.  One partition per physical drive

G

One partition (Drive G)
giDrive Management for Windows NT and Windows 2000 27



28
◆ Each partition is assigned a drive letter and 
cannot be further subdivided (Figure 23).

Choosing a File System

Both Windows NT and Windows 2000 support 
the NTFS file system. Because NTFS offers secu-
rity, improved file recovery, and integrated 
compression, you may want to use NTFS for par-
titions that will store system or applications 
data. However, it is strongly recommended that 
you use FAT 32 or FAT 16 to format DigiDrive 
partitions intended to store digital sound data. 
If you are using Windows 2000, you should use 
the FAT 32 file system. Windows NT does not 
support the FAT 32 file system and refers to FAT 
16 as “FAT” in the user interface.

Partition Size

Windows applications do not require specific 
partition sizes or file systems, so a wide range of 
partitioning schemes are possible. In general, 
smaller partitions offer somewhat better perfor-
mance, but the smaller the partition, the smaller 
the maximum file size. While the largest FAT 32 
partition allowed under Windows 2000 is much 
larger than the DigiDrive, Windows NT and FAT 
16 partitions are limited to only 4096 MB. 

Digidesign recommends that you partition 
DigiDrives into 4095 MB partitions. After parti-
tioning a DigiDrive this way, a block of free 
space may remain. You can choose to format 
this space or leave it unformatted. One advan-

Figure 23.  Four partitions per physical drive (the 
maximum)

G H I J

Four partitions (Drives G–J)
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tage to leaving small blocks unformatted is that 
it will prevent inadvertent Disk Allocation to a 
partition that is too small to be practical for au-
dio recording.

Creating Primary Partitions

To create a primary partition for Windows NT:

1  Start Windows NT 4.0 and log in to an ac-
count with administrative privileges. If you do 
not have administrative privileges, see your sys-
tem administrator to get privileges.

2  Click the Start button, point to Programs, and 
select Administrative Tools. 

3  From the Administrative Tools menu, click 
Disk Administrator. The first Disk Administrator 
window opens.

4  From the Windows NT Disk Administrator, se-
lect the disk on which you are going to create 
one or more primary partitions.

5  From the Partition menu, choose Create. The 
Create Primary Partition dialog box appears 
(Figure 24).

6  Choose the size of the primary partition by 
typing a number up to 4095MB or by clicking 
the up or down arrow.

Figure 24.  Create Primary Partition



7  Click OK to create the primary partition.

8  Repeat steps 1 through 4 to create up to four 
primary partitions. 

9  From the Partition menu, choose Commit 
Changes Now. The first Confirm dialog box ap-
pears (Figure 25).

10  Click Yes. The following Disk Administrator 
dialog box appears (Figure 26).

11  Click OK and follow the procedure explained 
in “Creating an Emergency Repair Disk” on 
page 31.

To create a primary partition for Windows 2000:

1  Launch Windows 2000 and log in to an ac-
count with administrative privileges. If you do 
not have administrative privileges, see your sys-
tem administrator to get privileges.

2  Go to Start > Settings > Control Panel.

3  Double-click Administrative Tools, and then 
double-click Computer Management. 

4  In the console tree under Storage, click Disk 
Management.

Figure 25.  Confirm

Figure 26.  Disk Administrator
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5  Beneath the disk name (located to the left of 
the disk), the display will indicate whether the 
disk is “basic” or “dynamic.” Pro Tools does not 
support dynamic disks. If the disk is dynamic, 
right-click on the drive name and select Up-
grade To Basic. 

6  Right-click an unallocated region of a basic 
disk, and then click Create Partition.

7  In the Create Partition wizard, click Next, 
then click Primary Partition. Follow the instruc-
tions on your screen. 

8  Microsoft's published limit for partition size 
with FAT 32 is 4 TB. You can choose any size par-
tition up to the complete capacity of the drive.
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Formatting Partitions

To format the primary partitions in Windows NT:

1  From the Windows NT Disk Administrator, se-
lect the primary partition you are going to for-
mat.

2  From the Tools menu, choose Format. The 
Format window opens.

3  Choose FAT File System (the FAT 16 file system 
is referred to by NT as simply “FAT.”) Type a Vol-
ume Label Name. You can enter up to 14 charac-
ters.

4  Select Quick Format.

5  Click Start to begin formatting. The Format 
warning dialog box appears.

Figure 27.  Format dialog

Figure 28.  Format warning
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6  Click OK. When formatting is complete, the 
Format Complete dialog box appears 
(Figure 29).

7  Click OK.

8  Repeat steps 1 through 8 until you have for-
matted all of the primary partitions you created.

You should now save the new disk configura-
tion to a floppy disk. See “Saving the Disk Con-
figuration” on page 31.

To format the primary partitions in Windows 2000:

1  From the Windows 2000 Disk Management 
window, select the primary partition you want 
to format.

2  Go to Action > All Tasks > Format.

3  In the Format window, enter a volume name.

4  Choose FAT 32 in the FileSystem pull-down 
menu.

5  Select 32k from the Allocation Unit Size pull-
down menu.

6  Select Quick Format.

7  Click Start to begin formatting.

8  Repeat steps 1 through 5 until you have for-
matted all of the primary partitions you created.

Figure 29.  Format Complete confirmation



Creating an Emergency Repair 
Disk
The Repair Disk utility saves all of your current 
system settings to an Emergency Repair Disk. 
You can then use this disk to restore your com-
puter if files become damaged.

Store the repair disk until needed. If you have a 
problem, search for Emergency Repair Disk in 
the Windows Help.

To create a repair disk in Windows NT:

1  Start Windows NT 4.0 and log in to an ac-
count with administrative privileges. If you do 
not have administrative privileges, see your sys-
tem administrator to get privileges.

2  Click the Start button and select Run. The Run 
window opens. 

3   Type rdisk /s and press the Enter key. 

4   Follow the instructions to create a repair disk. 

To create a repair disk in Windows 2000:

1  Go to Start > Programs > Accessories > System 
Tools. Click Backup.

2  In the Tools menu, click Create an Emergency 
Repair Disk. Follow the instructions that appear 
on your screen. 

3  Check “Back up the registry to the repair 
disk.”

It is strongly recommended that you create 
and update an Emergency Repair Disk every 
time you make significant changes to your 
hardware or software setup.

You will need a blank, PC-formatted, 1.44 
MB floppy disk to create an Emergency Re-
pair Disk
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Saving the Disk Configuration
This operation will save configuration informa-
tion about currently defined drive letters.

To create a configuration floppy disk in 
Windows NT:

1   Start Windows NT 4.0 and log in to an ac-
count with administrative privileges. If you do 
not have administrative privileges, see your sys-
tem administrator to get privileges.

2   Click the Start button, point to Programs, and 
select Administrative Tools. 

3   From the Administrative Tools menu, click 
Disk Administrator. The first Disk Administrator 
window opens.

4   Choose Configuration from the Partition 
menu and select Save. 

5   A dialog box appears asking you to put a 
floppy disk into the floppy drive. 

6   Click Yes. Store the configuration floppy disk 
until needed.

To create a configuration floppy disk in 
Windows 2000:

■ See your Windows 2000 Help Guide.

The repair process relies on information 
that is saved in the systemroot\repair 
folder. Do not change or delete this folder. 
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Keeping Your Hard Drive 
Tuned Up
Because Pro Tools is a disk-based system, keep-
ing your hard drives in good operating condi-
tion is essential.

Avoiding File Fragmentation

What is fragmentation? In multitrack recording, 
audio tracks are written in discrete files, spaced 
evenly across the disk. If the space required to 
write a discrete file is not available in a single 
contiguous block, the file is broken up into sev-
eral file fragments. This distribution of files and 
file fragments in blocks spread out over the sur-
face of hard drive disks causes playback to be-
come increasingly seek-intensive. The decrease 
in performance due to this process is continuous 
and progressive. As you add new sound files and 
edit existing files, the hard drive becomes in-
creasingly fragmented.

Defragment your drives To correct fragmentation 
and to prevent this gradual decrease in hard 
drive performance, use one of the hard disk 
maintenance utilities (for example Symantec’s 
Norton Speed Disk and Executive Software’s Dis-
keeper). These utilities will allow you to reas-
semble file fragments and reorganize discrete 
files into continuous so they are contiguous. 

How often? If you use your system for intensive 
editing, or if you frequently delete audio or fade 
files from your hard drive, you may need to op-
timize your drives on a weekly basis, or even ev-
ery few days, since it doesn’t take long for even 
a large hard disk to become fragmented.
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Correcting Disk-related Errors

With continued use, a hard drive’s file system 
can become corrupted. The best defense against 
this corruption is regular use of a disk repair util-
ity, such as NT’s ‘chkdsk’ or Norton Utilities. 

However, the most decisive way to resolve file 
system corruption is to backup your data and re-
format the drive. Therefore, if you are getting 
disk errors that cannot be resolved through the 
use of the disk repair utilities, it may be neces-
sary to backup your data (to tape or another 
hard drive), reformat the drive, and restore the 
data.

While Symantec and Executive Software 
both claim that the use of their products 
does not endanger the integrity of hard drive 
data, it is always a good idea to backup your 
data before defragmenting or reorganizing 
files and directories on your hard drive. It is 
also a good idea use a use a disk repair util-
ity (such as NT’s ‘chkdsk’ or Norton Utili-
ties) to find and correct file system errors 
prior to defragmentation.

The term ‘re-format’ refers to a high-level 
format, as performed by Windows NT's 
Disk Administrator or Windows 2000's 
Disk Management utility. This process 
erases all data and recreates the file system, 
but does not affect low-level sector and track 
information. 



Troubleshooting
Occasionally, you might have problems with a 
DigiDrive that you can repair on your own. The 
following sections present several scenarios and 
steps to take to repair them.

DigiDrive Does Not Turn On

When a DigiDrive does not turn on after you press 
the power switch:

1  Make sure the ac power cord is securely con-
nected to the drive enclosure.

2  Make sure the drive is plugged into a power 
strip or a wall outlet.

3  If the drive is plugged into a power strip, make 
sure the power strip is plugged into a wall outlet 
and that the power strip is turned on. After you 
turn on the drive, the green power LED on the 
front of the drive is lit.

DigiDrive Produces Errors

When a DigiDrive is producing errors or is act-
ing erratically, check the Event viewer for drive-
specific errors. The Event viewer is located in the 
Windows NT Administrator Tool Group, and 
under Disk Management for Windows 2000. 

For information that explains how to use the 
Event viewer, see your Windows operating sys-
tem documentation. 
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Digidesign System Fails to Boot

When the Digidesign system fails to boot:

1  Check that all SCSI devices on the bus have a 
unique SCSI ID. Duplicate SCSI IDs cause system 
problems.

2  Make sure all SCSI cables are properly con-
nected.

3  Check that the SCSI bus is properly termi-
nated, as described in Chapter 3.

4  If the system still does not boot or if it hangs, 
disconnect all SCSI drives and try to boot the 
system. If the system boots, either a drive, a ca-
ble, or the SCSI terminator might be defective. 

5  See the setup guide that came with your sys-
tem for additional troubleshooting informa-
tion.

6  Contact Digidesign Technical Support if you 
need additional assistance.
giDrive Management for Windows NT and Windows 2000 33



34
 DigiDrive Guide



appendix a

Specifications

The following sections provide dimensions and weights, and environmental, power supply, and 
power cord specifications for the Ultra 160/LVD DigiDrive.

Dimensions and Weights
Table 2.  Dimensions and Weights
Topic Specification

Width:
without interlock stacking brackets 
with interlock stacking brackets

7.50 in (190.5 mm)
8.18 in (207.7 mm)

Height
without interlock stacking brackets 
with interlock stacking brackets

2.69 in (68.3 mm)
3.12 in (79.2 mm)

Depth
without interlock stacking brackets 
with interlock stacking brackets

9.85 in (250.2 mm)
9.85 in (250.2 mm)

Weight
without interlock stacking brackets 
with interlock stacking brackets

7.0 lb (3.1 kg)
7.1 lb (3.2 kg)
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Environmental Specifications
Table 3.  Environmental Specifications 
DigiDrive Guide
Topic Specification

Room temperature 95°F (35°C) maximum

Operating humidity 5% to 90% noncondensing

Storage temperature -4°F to 185°F (-20°C to 85°C)

Storage humidity 5% to 95% noncondensing
Power Supply Specifications

Operating the drive at room temperatures 
higher than recommended will cause the 
drive to age prematurely and void your war-
ranty.

Table 4.  Power Supply Specifications

Topic Specification

Voltage 100 to 240 V ac autosensing

Frequency 50 to 60 Hz

Watts 20 W (typical)
40 W (maximum)



Power Cord Specifications
Choose the power cord according to the country 
destination; it must comply with local safety re-
quirements. Use the guidelines in the following 
sections to replace the original power cord. 
CEE-22 Power Cord Requirements

The female receptacle of the cord set, shown in 
Figure 30, must comply with CEE-22 require-
ments. 
Figure 30.  Receptacle (CEE-22)
United States and Canada Power 
Cord Requirements

In the United States and Canada, the male plug 
is a NEMA 5-15P style and is UL listed and CSA 
certified (Figure 31). SVT cord can be used with 
desktop or stackable units; all other equipment 
requires SJT cord. Only SJT-type cord sets can be 
used for units that rest on the floor. 

Table 5.  United States and Canada Power Cord Requirements

Cord 
Type

Size of Conductors in Cord Maximum Current Rating of Unit

SJT 16 AWG 12 A

SVT 18 AWG 10 A

SVT 17 AWG 12 A
Select the cord set according to the current rat-
ing of your unit. See Table 5 for the selection cri-
teria for power cords in the United States and 
Canada. 
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European Countries Power Cord 
Requirements

In Europe, use only an H05VV-F, <HAR>, VDE, 
PVC, 3 x 1.00 mm2 power cord (“NEMA 5-15P 
Style Plug” on page 38). Für den Gebrauch in 
Deutschland muß ein Netzkabel des Typs 
H05VV-F, <HAR>, PVC, Größe, 3 x 1.00 mm2 
verwendet werden. See Table 6 for the selection 
criteria for European power cords. 
DigiDrive Guide
Figure 31.  NEMA 5-15P Style Plug
Table 6.  European Power Cord Requirements
Cord Type Size of Conductors in Cord Maximum Current Rating of Unit

SJT 3 x 1.00 mm 2 10 A

SVT (not applicable) (not applicable)



appendix b

SCSI Cables and Terminators

SCSI Cables

Use only the highest quality SCSI cables available when connecting a DigiDrive to your Digidesign 
system. Digidesign recommends the use of SCSI cables supplied by Avid Technology. These cables are 
specifically designed for systems that run real-time applications, and their lengths and electrical prop-
erties are designed to ensure data integrity on the SCSI bus. Descriptions and illustrations are pro-
vided in Table 7, which also shows a list of Avid-supplied cables that are available for connecting both 
wide and narrow drives to your Digidesign system, and where to use each cable.
Table 7.  SCSI Cables
Cable Type Length Purpose

Macintosh system 
built-in SCSI to first 
narrow drive

25-pin to 50-pin 30 inches To connect the first narrow drive to the Macin-
tosh external SCSI bus.

SCSI accelerator 
board to first drive

68-pin to 50-pin 30 inches To connect the first narrow drive to the Digide-
sign SCSI bus. Use only on SCSI buses that con-
tain no wide drives.

68-pin to 68-pin 30 inches To connect the first wide drive to the SCSI bus 
or a single-channel SCSI accelerator board.

60-pin to 68-pin 30 inches To connect the first wide drive to a dual-channel 
SCSI bus.

SCSI cabling 
between drives

50-pin to 50-pin 15 inches To connect vertically stacked narrow drives.

50-pin to 50-pin 30 inches To connect side-by-side narrow drives.

68-pin to 68-pin 15 inches To connect vertically stacked wide drives.

68-pin to 68-pin 30 inches To connect side-by-side wide drives.
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SCSI Terminators and Adaptors

The Pro Tools SCSI chain must be properly terminated or your system will not function properly. 
Only the last device on the chain should be terminated. Depending on the configuration of your 
drives, you will need one of several different types of SCSI terminators and adapters to cover the vary-
ing style of connectors found. Descriptions and illustrations are provided in Table 8.

Digidesign recommends the use of SCSI terminators supplied by Avid Technology. These color-coded 
terminators are specifically designed to ensure data integrity on the SCSI bus for systems that run real-
time applications. Avid terminators are available through your Digidesign dealer.

You need to connect an ultra, wide-to-narrow SCSI adapter to change from 68-pin cabling to 50-pin 
cabling. The adapter terminates the unused lines to help prevent any SCSI bus problems.
Table 8.  SCSI Terminators and Adapters
DigiDrive Guide
Type Style Description

50-pin terminator Fast, narrow terminator for SCSI buses that have only 
narrow drives (purple).

50-pin terminator Ultra, narrow terminator for SCSI buses that have a 
mixture of wide and narrow drives (blue).

68-pin multi-mode 
terminator

Ultra, wide terminator for wide drive SCSI buses which 
run in LVD or Single-ended mode (blue).

68-pin to 50-pin 
adapter

Ultra, wide-to-narrow terminating adapter for connect-
ing wide and narrow drives (blue).



Maximum Configurations
Table 9 lists the maximum number of DigiDrive LVD enclosures that can be connected in various 
configurations.

If you increase the length of the cables listed below, you must reduce the number of drives in the 
daisy-chain.
Table 9.  DigiDrive LVD Configurations
Number of DigiDrive LVD 
Enclosures

Cable Length from 
Host System to 

First Drive

Cable Length 
Between Drives

Comments

15 DigiDrive
LVD enclosures

30-inch 15-inch This configuration uses the 
maximum number of LVD 
drives but requires that the 
cable lengths be at a mini-
mum.

10 DigiDrive 
LVD enclosures

10-feet 30-inch This configuration provides a 
greater distance between the 
host system and all the 
drives.

8 drives 
(any combination of DigiDrive 
LVD and single-ended)

30-inch 15-inch or 30-inch This configuration includes 
DigiDrive LVD and single-
ended drives.
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SCSI LVD Cables

Digidesign strongly recommends the use of Avid SCSI cables when you are attaching DigiDrives to 
the accelerator board on your Pro Tools system. These cables are specifically designed with electrical 
properties that ensure data integrity on the SCSI bus—either LVD or single-ended.

An Avid 30-inch, 68-pin to 68-pin SCSI LVD cable is supplied with each DigiDrive LVD enclosure. A 
green sleeve on the cable denotes that it is an LVD cable. All LVD cables (regardless of length) have 
green sleeves.
Avid SCSI LVD Cables Available for Purchase
DigiDrive Guide
SCSI LVD Terminator

Avid's patented multi-mode terminator is included with each DigiDrive. The Avid LVD terminator de-
tects the SCSI bus mode. The LED is green when the SCSI bus is in LVD mode, and amber when the 
SCSI bus is in single-ended fast, wide mode.

Cable Length Purpose

Host Bus Adapter (HBA) cables — 68 VHDCI-pin to 68 HD-pin connectors

10-feet Available for connecting the first DigiDrive LVD enclosure to the host sys-
tem (optional)

30-feet Available for connecting the first DigiDrive LVD enclosure to the host sys-
tem (optional)

Daisy-chain cables — 68 HD-pin to 68-HD pin connectors

30-inch Ships with the DigiDrive LVD enclosures. Can be used for connecting the 
first DigiDrive to the host system or for providing SCSI connection 
between DigiDrives
Avid SCSI LVD Terminator

LED
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